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What is Aqua4Plus?

Aqua4Plus is Seametrics’ easy-to-use Windows-based software for communicating with  
and controlling Seametrics’ state-of-the-art Smart Sensors. 

Aqua4Plus is designed to control a number of separate sensors. Aqua4Plus  
communicates with Seametrics Smart Sensors using the industry standard Modbus®  
communication protocol.

Smart Sensors collect and store data internally as user-programmed in Aqua4Plus. The 
Aqua4Plus software is also used to view, retrieve, and export the collected data. 

System Requirements

• Desktop or laptop computer running WinXP(SP3) or higher
• 20 MB free hard drive space
• USB port for installing the program and for communicating with sensors. (The 

program can also be installed over the Internet.)
• NOTE: The software may not work reliably on ultra-high definition (4K) laptops and 

monitors.

About this Manual

This manual contains in-depth instructions on basic aspects of using Aqua4Plus,  
including initial setup, controlling the sensors, and retrieving data.

INTRODUCTION
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Connecting the Sensor to a Computer

In its cabled configuration, the sensor cable is terminated with a weather-resistant  
connector.  In its cableless configuration, the sensor is terminated with a weather- 
resistant connector inside a screw-cap. Connect the weather-resistant connector to  
your computer’s USB port as shown below.  (For alternate connection options,  
see Appendix E.)

  Connect the sensor to your PC using a USB to RS485 adapter.  
  (See Appendix E for alternate connection options.)

When using Aqua4Plus with Seametrics’ USB/RS485 cable, drivers will need to be 
installed on your computer. If you are connected to the Internet when you first plug in 
the cable, it will normally obtain and install the correct drivers automatically. If this does 
not  
happen or if you do not have Internet connection, you can use Aqua4Plus to install the 
drivers. From the Utilities Menu, select Install USB/RS485 Drivers. Select your  
Windows operating system, and then click Install.

Installing the Aqua4Plus Software

If your software is supplied on USB stick:

1. Insert the USB stick into your PC or laptop. 
2. Using Windows Explorer, navigate to the Aqua4Plus Standard folder on the USB 

stick.
3. Double click on setup.exe
4. The Installation program will guide you through the installation process.  

From the Internet:

1. Download Aqua4Plus from www.seametrics.com 
2. Unzip the file onto your computer.
3. Double click setup.exe
4. The Installation program will guide you through the installation process. 

PC or Laptop
Computer

USB Port

USB to RS485
Adapter

Sensor
Cableless 

Configuration

Screw-

Sensor

cap
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Once the software has successfully completed installation, you can remove the USB stick  
from your computer and store it in a safe place. 

To start the Aqua4Plus software, use the Start Menu to navigate to the program group 
you selected during installation (typically this will be Aqua4Plus), and then click the 
Aqua4Plus      icon.

First Time Setup

If you have just installed Aqua4Plus, please take a few minutes to go through the setup 
options and configuration.

Options Menu

Use the Options Menu to control settings for the Aqua4Plus software. (Use the  
Configure Menu to control settings for sensors.)

Display Units - Use this option to select the units in which to display 
your data. This  will control how data is represented 
on the Real Time Monitor, the File Display Window, the 
Graph Window, and for exported data.  

Default Folder - Aqua4Plus saves and looks for files in a default folder. 
Use this option to select a default folder location. 

Communication - Use this to set the communications options for 
communicating with the sensor.  

  A. Set the Lowest and Highest sensor addresses you will 
be scanning.

  B. If you are using a COM port higher than 8, increase 
the Highest COM port to at least that high (maximum of 
15).

  All other settings will automatically adjust, and you will  
rarely need to make changes unless instructed to do so 
by a Seametrics service representative.

Baud Rate - Set baud rate for Aqua4Plus. Note: Change sensor baud 
rate under Configure Menu, Advanced option. 

Change Password - Change the password that is required for some advanced 
options.

INTRODUCTION
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Communication Options

INTRODUCTION
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Configure Menu 

Use the Configure Menu to set options on individual sensors. Note that not all options 
will be available on all types of sensors. The program determines what sensor you are 
connected to and lists configuration items available for that sensor. In order to access 
items on the Configure Menu, you must first connect to and select the sensor whose 
configuration you want to set. (See Finding, Selecting, and Viewing Sensors, page 10.)

Sensor Clock* - A popup box displays the time currently in the 
sensor and on your computer. To set from the 
computer’s clock, click “Set from Computer Clock” 
and then click the Set Clock button. To specify a 
time, click “Set to Selected Time.” Select the date and 
time, and then click the Set Clock button.

Sensor Description* - Use to enter a description for a particular sensor.  
This information is displayed on the Sensor Window  
and is recorded with the collected data. 

Sensor Address* - If you are connecting to several sensors, each sensor  
must have a unique address. This is also known as 
the Modbus address. Use this option to set the 
address.

 - Addresses must be between 1 and 255. Be sure to 
set the Lowest and Highest Sensor Addresses to 
include all addresses that you are using (see Options 
Menu | Communication.)

Sensor Continuous Rate*** - Some sensors can take readings more often than 
once per second.  This is known as a “continuous 
rate.” Different sensors have different available rates.  
Use this option to select the rate you want to use.  
This rate will be saved to the sensor.

 - See the “Creating Logging Schedules” section on 
how to set continuous logging.  If this option is not 
available, then the selected sensor does not support 
continuous rate functionality.

Battery Information Reset*** - See Appendix B         
Erase All Data -   Erases ALL data in the currently selected sensor.
Settings & Calibration* - Use this option to change some settings and to 

adjust the calibration on the sensor. Note that 
different types of sensors will have different 
calibration procedures. Refer to the specific sensor 
manual for information for that sensor.

INTRODUCTION
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Advanced  
Download Firmware** - Downloads an updated version of the firmware to 

the sensor, requires a password. Contact Seametrics 
factory personnel for details.

Filtering Level*** - Some sensors have the ability to apply some filtering 
to incoming data in order to smooth out minor 
variations in readings. See the sensor manuals for 
details.

Sensor Baud Rate*** - Sets alternate baud rate on sensor – 38400 (default), 
19200, or 9600.

SDI-12 Seup*** - On some sensors, you can specify what SDI-12 
commands return readings from which channels. If this 
is not visible, then it is not available for the connected 
sensor.

Direct Read Units*** - Use to set engineering units when not using 
Aqua4Plus.

Depending on the sensor, there may be additional options. Refer to specific sensor 
manuals for details.

 

 

*	Available	to	view	but	not	change	if	there	are	any	files	stored	on	the	sensor.
**	Not	available	if	there	are	any	files	stored	on	the	sensor.
*** Not available on all sensors.

INTRODUCTION



AQUA4PLUS INSTRUCTIONS

Seametrics • 253.872.0284 Page 9 inwusa.com

In addition to the standard menus and tool bar, Aqua4Plus has a “Simple” tool button 
bar that can be turned on. This “floating” tool button bar provides quick access to most 
common functions. The tool bar may be moved wherever you want on the screen and 
it will always stay on top in easy reach. When you close Aqua4Plus, it will remember the 
last location and return there once the program is reopened.

    

By default, the Simple Button bar is not activated. To activate the Simple Button bar, 
select Simple Buttons from the View Menu. From the popup box, you can select to turn 
off the button bar, use the button bar with Latin characters, or use the button bar with 
Non-Latin characters. When selecting Latin characters, you can customize the text on 
the buttons, if desired. When selecting Non-Latin characters, the only current option is 
Japanese. Click OK to save your changes.

Scan for any connected sensors

Set up a logging schedule

Retrieve data from a sensor

Change settings and/or calibration on a 
sensor

Open a data file from the computer

Export a data file to .csv or .xls format

SIMPLE BUTTONS
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Selecting a Communication Port

Aqua4Plus communicates with the smart sensors via a USB or a COM port on the  
PC. When Aqua4Plus is first opened, it polls the computer for all available 
communication ports. These are then listed in the connection port drop-down box on 
the tool bar. By default, Aqua4Plus looks for USB and COM 1 through COM 8. If you are 
using a higher COM port, specify the highest COM port on the Communications dialog 
box under the Options menu. 

To select the port you  are using, click on the down arrow, and then click on the port to 
which your sensor is connected. 

Connection Port Drop-Down Box
 

Finding, Selecting, and Viewing Sensors

Once the port has been selected, open the Sensor Window by clicking the  tool  
button  (or View Menu | Sensor Window). The software will scan for  any connected 
sensors.  A list of connected sensors will appear on the Sensor Tree. 

On the Sensor Tree, double-click to select a sensor. A list of data files stored on the 
sensor will be displayed below the sensor. Information regarding the selected sensor will 
display in the Sensor Information Panel to the right of the Sensor Map.   

Sensor Tree and Sensor Information Panel

Click here to get additional 
details, as shown below.

NORMAL OPERATION



AQUA4PLUS INSTRUCTIONS

Seametrics • 253.872.0284 Page 11 inwusa.com

Note that the information shown on the Sensor Tree and the Sensor Panel is static  
information. In other words, the program looks at the sensor and displays the  
information, but it does not keep going back to the sensor and getting the newest  
information. This is to save battery life on the sensor. To update the information on  
the Sensor Tree and the Sensor Panel, click on the “Refresh Selected Sensor” button 
below the Sensor Tree. This will requery that particular sensor and update the display.

Sensor Tree: 

The Sensor Tree displays a list of all sensors connected to the selected port. If no port 
is selected or no sensors are connected to that port, this tree will be empty. The Sensor 
Tree is an expanding tree display. Double-click on a sensor to expand the display to show 
data files, if any, currently stored on that sensor. Click on the  to the left of  
a sensor to hide the display of files for that sensor.

The different icons in front of each file indicate the current status, as follows:

   Completed - has run to completion or has been terminated.

   Paused  - has been paused by operator.

   Pending - awaiting a delayed start time.

   Active - currently logging.
       Configuring data area

Sensor Information Panel:

The top right portion of the Sensor Window displays information pertaining to the  
sensor that is selected on the Sensor Tree. This information will vary, depending on  
the type of sensor selected. Typical information may include:

Status: Active  - sensor is currently logging.
 Paused  - logging has been paused.
 Pending  - logging is awaiting a delayed start time.
 Inactive  - no active, paused, or pending logging.
 Configuring... - configuring data area

Files: Number of data files stored on selected sensor.
 Maximum of 60.

Power: Battery or Auxiliary.

Free: Approximate number of records that can be stored before  
 the sensor memory is full.  Total number of records varies  
 by sensor type.

Battery: Battery indicator - if Green, the battery is good, if  Yellow,  
 it is low, if Red, it is critically low.  

NORMAL OPERATION



AQUA4PLUS INSTRUCTIONS

Seametrics • 253.872.0284 Page 12 inwusa.com

To view further details, click the ellipsis  in the upper right corner for a drop-down 
information panel. Typical information for this drop-down panel may include:

Sensor Description: User assigned description. (Set this description on the
 Configure Menu | Sensor Configuration | Set Sensor  
 Description Option.)  

Sensor Type: Factory assigned sensor type.

Modbus: This is the assigned Modbus address for the sensor. 
 Each connected sensor must have a unique Modbus  
 address. This address must be between 1 and 255.
 (Set this address on the Configure Menu | Sensor  
 Configuration | Set Sensor Address.) 
 
Serial Number: Factory set sensor serial number.

Firmware Revision: Sensor firmware revision number.

Range/Element: Sensor range and element information may also be displayed.

Using the Real Time Monitor

Real Time Monitor

Use the Real Time Monitor (lower part of Sensor Window) to view live readings from 
the sensor that is selected on the Sensor Tree. These readings are not being recorded in 
the sensor, but only displayed for real time viewing. The Real Time Monitor can be used 
whether or not the sensor is actively recording. 

To obtain and display a single reading, click the Single button.

To obtain and display readings continuously for 60 readings, click the Start button. 

To stop the monitor, click the Stop button. 

NORMAL OPERATION
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The Monitor displays a column for the sensor date/time and for each parameter being 
collected. Use the horizontal and vertical scroll bars as needed to adjust the view.  
Readings are displayed in the units selected from the Options Menu. For example,  
pressure might be displayed in psi or in Ft  H2O, or something else. (See earlier section 
for details on the Options Menu.)

Logging 

The Smart Sensor collects and stores data.  A series of steps is programmed describing 
the number of samples to record and the sampling intervals. Several files can be in the 
Smart Sensor memory at any one time, several completed files (along with their data) 
and one active file. An active file can be either logging, paused, or pending (waiting for a 
delayed start time). The maximum number of records that can be stored depends on the 
type of sensor. Check your sensor documentation for details. 

The Logging Schedule Window is used to create and/or view logging schedules. A 
schedule is a description of the test steps necessary for a particular test. Schedules can 
be saved to disk for later use or sent to a sensor. Note: There can only be one active 
schedule on a sensor. Once a new schedule is sent to a sensor, any currently active 
logging is terminated and the new schedule begins. All previous logs on the sensor are 
retained, along with their data, until erased, but cannot be run again.

    Logging Schedule Window

NORMAL OPERATION
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Creating Logging Schedules:

1. Create a new schedule  by clicking the  tool button (or Logging Menu | New 
Logging Schedule).  A Logging Schedule Window will open.

2. If you want to open a previously saved schedule, click the Open button, and then 
select the schedule you want. If you are satisfied with this schedule, skip to step 8. 
Otherwise, continue with the following steps.

3. Name your file by entering a name in the File Name box.
4. Describe test phases. Each schedule consists of up to 10 test phases. During data 

collection, these phases will be executed one after the other in sequence. Each 
phase can have different polling intervals and/or number of records. For example, 
you might want to record a reading every five seconds for 100 records, every 30 
seconds for 100 records, and then every five minutes for the next 1000 records.  
The length of each phase shows in the right-hand column. The entire recording 
length shows at the bottom of the window.
To describe a test phase: 

 ◦ Click in the Polling Interval column for the first phase.
 ◦ Enter your polling interval for this phase as dd/hh:mm:ss, where “dd” is 

number of days, “hh” is number of hours, “mm” is number of minutes, and 
“ss” is number of seconds between recordings. You only need to enter the 
smallest time interval you are using. For example, if you want a sample 
recorded every 10 seconds, you only need to enter 10 and then press the Tab 
key. The days, hours, and minutes will default to zero. Likewise, if you want a 
sample recorded every hour, you would enter 01:00:00, and the days would 
default to zero.

Some sensors can take readings more often than once per second.  This is known 
as a “continuous rate.”  Different sensors have different available rates.

To use the continuous rate for a particular phase, enter the letter ‘c’ in the polling 
interval rather than a specific time interval.  The sensor will then use the rate that 
had been saved on the sensor using the Sensor Continuous Rate option on the 
Configure menu.

 ◦ Enter the number of records to record at this polling interval.
 ◦ Press the Tab key and continue entering phases, as desired. (Note: Some 

sensors can only record one phase.)

NORMAL OPERATION
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5. If desired, select Delayed Start: Click the Delayed Start checkbox. Enter the date 
and time to start. Time is in 24 hour format. This option is especially useful when 
you want to collect and compare data from several sensors. Create a schedule; 
save it to disk. Connect to each sensor in turn and send the schedule to that sensor 
by clicking the start button. Note: For accurate data, be sure the clocks in all the 
sensors have been set to the same time. To do this automatically, checkmark the 
Set Sensor Clock on this window. (Alternately, see the Configure Menu for details 
on setting the clock).

 ◦ Entering Date: Click on the day, month, and year and enter the desired start  
date.  To select from a calendar, click on the down-arrow next to the date and 
time.  Select your start date from the calendar.

 ◦ Entering Time: Click on the hours, minutes, and seconds and enter the 
desired start time.

 Note on Date:  Internally in the sensor, only the day of the month is stored.   
Logging will start the next time the day of the month matches the day of  
the month you selected - regardless of the month!  For example:  Suppose 
you select January 8th as your start date.  The sensor will start the first time 
the day of the month is equal to 8.  If today is January 5th, then it will start on 
January 8th.  If today is January 20th, it will start on February 8th.

6. If desired, checkmark Set Sensor Clock. If this is checked, the program will set the 
sensor clock to match the computer clock when sending the schedule information 
to the sensor. (Note: If this is not checked and the program detects that the sensor 
clock is more than five minutes different than the computer clock, it will give you 
the option of setting the clock.)

7. Repeating Schedules. Some sensors support repeating schedules. When a  
repeating schedule is selected all phases will run once and then the repeat. This will 
run over and over until all specified repeat times have elapsed or until the memory 
is full, whichever happens first. If your sensor supports repeating schedules there 
will be a checkbox labeled Repeat Schedule on the Logging Schedule window. 
Checkmark this box and then enter the number of times to run the schedule.

8. If desired, save the schedule to disk for future use: Click the Save As button,   
enter a file name or leave as is to accept the current file name, then click the  
Save button. 

9. Send schedule to the sensor: Once you are satisfied with the schedule, you must 
send the it to the sensor. To do this, click the Start button.  If you selected a delayed 
start time, the sensor will wait until the specified time and then begin collecting 
data, otherwise data collection will begin immediately.   
(Note: Sending a schedule to the sensor will terminate any active, paused, or 
pending schedules - it will not erase any data.)

NORMAL OPERATION
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Pausing and Resuming:

You can manually pause and resume the logging on the sensor. To pause, click on the 
active file on the sensor map. (The active file will have a green icon  in front of the 
name.) Once the file has been selected, open the Logging Menu and select Pause. A 
hand icon  will display in place of the green icon. 

To resume click on the paused file to select it. Open the Logging Menu and select  
Resume. The hand icon will once again change to a green icon. Note: you cannot  
resume a terminated or finished file, one with a blue checkmark .

Terminating:

Active logging (running , paused , or pending ) can be terminated manually at 
any time. On the Sensor Tree, click on the file to select it. Open the Logging Menu, and 
then select Terminate. The icon will be replaced by a blue checkmark .

Erasing Data:

To erase all data from the Smart Sensor, open the Configure or Logging Menu, and then 
select Erase All Data. You cannot erase individual files. Erasing deletes ALL data on the 
sensor. Be sure you have retrieved all important data before erasing. 

Note: Many activities are also available by right-clicking the file name under the sensor.

Retrieving Data

• If the data files are not displayed on the Sensor Tree, double click on the sensor 
from which you will be retrieving.

• Click on the file you want to retrieve.

• Click the   tool button. The Save dialog box displays.
• Enter a file name or leave as is to save with the current file name.
• Select a file type (optional). Retrieving always saves the data in the Aqua4Plus Data 

File (.a4d) format. Files can additionally be saved in alternate formats. 
• Click the Save button.
• Click Start.
• When retrieval is complete:

 ◦ If you retrieved only the Aqua4Plus Data File (.a4d), you can now click on the 
Done button, or you can click on the View button to view the data in the File 
Display window. (See more details on the File Display window in the next section.)

 ◦ If you retrieved in Text (.csv) format, the file will automatically be opened in the 
File Display window, and you will also be given the option of viewing it in Excel. 
(Note, you must have Excel installed on your machine in order to make use of this 
option.)

NORMAL OPERATION
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Viewing Data

Aqua4Plus displays collected data in both a tabular format and a graphing format. 

Displaying Data in Tabular Format:        

File Display Window 

Click on the open button  (or File Menu | Open). Navigate to the desired file, and then 
click the Open button.   

The File Display Window consists of two panels. The top panel displays various  
information about your data, such as number of records, file name, sensor name, etc.

The lower panel displays the actual data. The first few rows display statistical data about 
your records, including minimum, maximum, and mean values, as well as the variance 
and standard deviation. The remaining rows display the actual data. 

Click on the graph button  to switch to graphing view. You can switch back to the  
tabular view by clicking on the file display button .

NORMAL OPERATION
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Displaying Data in Graphing Format:

Graphing Window

Click on the graphing icon  to open the Graphing Window. This window displays data 
that has been saved on your computer (files with an extension of .a4d). Navigate to the 
desired file, and then click the Open button.  

The graphing window is a free-floating window and can be placed outside the main 
Aqua4Plus window frame. It is often easier to view the graph with the graphing  
window maximized. Click the maximize button  in the upper right corner of the 
graphing window to view in maximized mode.

 Click to open a new file. (Alternate = File Menu | Open)

 Click to export the graph as a graphic file (.jpg, .gif, .bmp, or .png).  
(Alternate = File Menu | Export Graph)

 Click to print the graph. What is seen on the screen will be printed – i.e., if notes 
or statistics are turned on, they will print. If the graph is zoomed in, it will print 
only the area showing on the screen. 

 Click to copy and paste to the Window’s clipboard. Only the graph will be 
copied. To copy the Notes, highlight the notes and then click copy.

 Click to open the Display Setup dialog box and change various display  
attributes. 

NORMAL OPERATION
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Graph Display Setup

Channel - Lists all channels available to be plotted for the  
particular data file.

Plot - Click to toggle whether or not to plot any particular 
parameter. Note: Time is always plotted and is always 
along the bottom of the graph.

Legend Position - The legend for any parameter (except Time) can be 
displayed either to the left or to the right of the graph. 
Click here to toggle between left and right. 

Scale Limits - Click to rotate among the following options:
Full Scale - Minimum and Maximum scales set to full scale for that 

channel on the sensor whose data is being displayed.
Data - Minimum and Maximum scales set to minimum   

and  maximum data values for that channel in the  
displayed data file.

User - Set your own Minimum and Maximum scales.
Scale Min/Max - Displays current Minimum and Maximum scale values. 

Click and type in these boxes to change values for User 
defined scales.

Grid Line - Enable grid lines for any particular channel.                
Note:  Grid lines only show on the graph when the grid 
lines tool button is depressed.

Plot Color - Click to change color for any particular channel. Click  
the color under grid to change the grid line color for that  
parameter.

NORMAL OPERATION
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 Click to add notes to your graph. You can add up to 500 words below the 
graph. 

 Click to display statistics below the graph (min, max, mean, variance, standard 
deviation, and field calibration values). 

 Click to turn grid lines on or off.  Only grid lines enabled on the display setup 
will show.

 Click to turn discrete points on or off.

 Click to change from color to black and white. Some printers print better in 
plain black and white.

 Click to change the size, color, and style of the font. Note that size and style 
affect all fonts on the graph, while color affects only the title.

 Click to zoom in. Cursor will change to an arrow with an attached box. Click and 
drag to enclose the area you want to zoom.

 Click the down arrow to right of icon to select scale:
Full Scale - Minimum and Maximum scales set to full scale for ALL 

channels on the sensor whose data is being displayed. 
(Set individual channels, if desired, under Display   
Setup .)

Data - Minimum and Maximum scales set to minimum and 
maximum data values for ALL channels in the displayed 
data file. (Set individual channels, if desired, under 
Display Setup .)

User - Select the user defined Minimum and Maximum scales 
specified under Display Setup .

Exporting Data

• Using the File Display window, open the file you want to export.
• Click on the   tool button.
• Select a file type, either the default Text (.csv) or Excel (.xls).
• Select a file location and enter a name for the file or leave as is to accept the current 

file name.
• Click Save. You will be given the option of viewing it in Excel. (Note, you must have 

Excel installed on your machine in order to make use of this option.)
* If you are using Windows 10, you will not be given the option of exporting to .xls or to 
open	the	file	in	Excel.	It	will	simply	export	the	data	to	a	.csv	(comma	separated	values)	file.	
See	Importing	Data	Into	a	Spreadsheet,	below,	on	how	to	import	the	.csv	file	into	Excel.	

NORMAL OPERATION
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Importing Data Into a Spreadsheet

To import data to a spreadsheet or database, you must first Retrieve and Export the  
data to a .csv or .xls file. (See previous sections on retrieving and exporting.) Most 
spreadsheets and databases can readily import .csv files. Microsoft® Excel can import 
either .csv or .xls files.  Following are instructions for importing a data file into Excel. For 
importing into other programs, see documentation with the particular program. 

• Open Excel.
• Click on the File menu, and the select Open.
• On the Open dialog box, click the down-arrow to the right of the File Types 

dropdown box.
• Click the option All Files.
• Navigate to the saved file, and then click the Open button in the lower right corner 

of the dialog box.

The data will be opened in Excel. (Note: While Aqua4Plus can handle over 500,000 
records, Excel versions prior to version 2007 were limited to approximately 65,000 
records.)

NORMAL OPERATION
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Appendix A: Sensor Setting and Calibration

To adjust sensor channel offsets, calibration, depth-to-water or elevation, and other 
various settings, select the Settings and Calibration option on the Configure Menu. In 
the Settings and Calibration window, click on the channel you want to adjust. Specific 
instructions for each channel are displayed in the right panel. Different sensors have  
different available settings. Refer to the specific sensor manual for further details.

Settings and Calibration Window

SETTING AND CALIBRATION
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Appendix B: Battery Information and Reset

Some sensors have an internal battery life calculator based on usage and type of  
batteries. If your sensor supports this feature, it will be available from the Configure 
Menu - Battery Information and Reset. Whenever you change batteries in your sensor, 
you should open this window, checkmark the box that says you have just put in new 
batteries, and select the battery type. Once this has been done, the battery level  
displayed on the main sensor panel will show the estimated life remaining as a  
percentage*. If your sensor does not have this feature the battery level on the sensor 
panel will show the actual battery voltage rather than percent of life remaining.

Battery Information and Reset Window

* If your sensor has this feature but it has not been set, then the battery life bar may not 
display on the sensor panel.

BATTERY INFORMATION & RESET
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Appendix C: Batch Operations

Aqua4Plus can start logging on several sensors with a single command.  Likewise, data 
can be retrieved and/or erased from several sensors at once.  This functionality works on 
PT2X, CT2X, and TempHion Smart Sensors.

Accessing Batch Operations

The Batch Operations commands are located on the Logging Menu. Click on Batch 
Operations and a fly out menu will list the available options.

Each batch operation will display a batch processing window, as shown below:

Batch Processing Window

All supported sensors that are on the main Aqua4Plus sensor window will display in 
the batch processing window. Each sensor has a checkbox in front of it, allowing you to 
select which sensors will be part of the batch operation. All boxes are checked when the  
window opens. Select or deselect individual sensors by clicking the checkbox. You can 
also select all the sensors or deselect all the sensors by clicking the respective buttons  
at the top of the form.

The batch processing window displays sensor information for each sensor, including 
sensor type, sensor name, sensor address, and the number of files currently on the 
sensor. There is also a status column, which displays the progress and status of a batch 
operation, including any error messages that might be generated.

BATCH OPERATIONS
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Starting Batch Logging

Batch Logging Configuration 

To start new logging on a group of sensors, select Batch Operations from the Logging 
menu, and then click on Set Up New Batch Logging. The following schedule window will 
display.

Batch	Logging	Configuration	Window

You can load and modify a saved schedule or create a new one. If you want to open 
a previously saved schedule, Click the Open button, and then navigate to the saved 
schedule. 

File Name: Enter a name for your configuration. This name will be part of the final file 
name - see details on file naming in the Retrieving Batch Data section below.

Delayed Start: If you want all your sensors to start at exactly the same time, enter a 
delayed start time here. Be sure to select a time far enough in the future to allow the 
configuration information to be broadcast to all sensors prior to that time. With directly  
connected sensors, this time need not be more than a minute or two. An error  
message will display if the schedule is not sent to all the sensors before the set delayed 
start time.

Set Sensor Clocks: Checkmark this box if you want Aqua4Plus to reset the clocks on all 
the sensors prior to starting to log. (The clocks will be set to the time on the computer 
running Aqua4Plus. This is recommended so that your collection times will match from 
one sensor to another.)

Phase Information: Describe your collection intervals and number of records, as  
desired. (Note: If using a continuous interval, see note on Continuous Polling Interval.)

BATCH OPERATIONS
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Save As: If you want to save this schedule to disk before loading to the sensors, click the 
Save As button now. 

Select Sensors: Once you have defined your schedule, click the Select Sensors button. 
This window will close and the batch logging start window will display, as shown below.

Batch Logging Start Window

Continuous Polling Interval

When using batch processing, the goal is to have each sensor record for the same amount 
of time, with each phase lasting the same length of time from one sensor to the next. This 
makes it easy to compare data from various different sensors. 

Most Seametrics Smart Sensors can be set to a continuous polling interval. This interval 
varies from sensor to sensor and can be set on any particular sensor by selecting the Sensor  
Continuous Rate under the Configure menu. 

Due to the fact that sensors may have different continuous rates, if you want to set a phase 
to be continuous in batch mode, you will need to specify the phase duration for that phase, 
rather than specifying how many records will be recorded during that phase. The minimum 
phase duration is 10 seconds.

To indicate that a phase is a continuous phase, enter a letter C in the polling interval. The 
phase information will display as follows:

Enter the Phase Duration as dd/hh:mm:ss. When the schedule is sent to the sensor during 
the starting process, the program will determine the correct number of records for that 
sensor to record to match the phase duration you have set.

BATCH OPERATIONS
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Be sure the sensors on which you want to start logging are selected, and then click the 
OK button. When you click OK, several things happen. 

• Current status is gathered from each sensor.
• Available memory space is checked on each sensor.
• The clocks are reset (if so specified in schedule).
• The schedule information is sent to each sensor.
• The Start command is issued to each sensor.

Progress information for each sensor will be listed in the status column and overall 
progress information will be shown in bold lettering at the lower left of the window.

Notes:

• If you checked the Set Sensor Clocks option in the schedule, all sensor clocks will  
be set to the current time on the computer running Aqua4Plus just before logging 
is started. All clocks will be set at the top of a second. 

• If you selected a delayed start time, all schedules will be sent to the sensors and  
logging will start at the appointed time. If the appointed time has passed before all 
the schedules have been loaded to the sensors, an error will be generated. See Error 
Reporting on next page.

• If you did not select a delayed start time, each sensor will be started in turn at the 
top of the next second. When directly connected this may result in each sensor 
starting one second after the previous one. If it is important that logging start at  
the same time, you must use the delayed start feature. 

When the operation is finished, the status column will display the result of the operation 
for each sensor. If logging started successfully, the status column will say Logging 
Started, and the number of files on the sensors will be updated. Click the Close button to 
exit the batch processing window. 

Logging Succesfully Started

BATCH OPERATIONS
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Error Reporting

If any error occurred during the operation, a message box will display at the end of  
the operation. Also, the affected sensor will display in red and an error message will 
display in the status column. If you want to try again, select the desired sensors, and 
then click the OK button; if not, click the Cancel button.

Error in Starting Logging

Retrieving Batch Data

The batch retrieve operation retrieves the last file on each sensor that is selected in the 
batch processing window. 

To retrieve data from a group of sensors, select Batch Operations from the Logging 
menu, and then click on Retrieve Batch Data. 

The following batch processing window will display.

Batch Retrieve Window

BATCH OPERATIONS
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Be sure the sensors from which you want to retrieve data are selected, and then click the  
OK button. 

You will be asked to select a file folder in which to save your files. The default is the 
folder you have selected as your default data folder under the Options menu.

As the files are retrieved, they are named as follows: 

 sensorname_filename_serialnumber.a4d

 where:

 sensorname = the name you have given to the sensor with the  
   Sensor Description option under the Configure menu. 

 filename = the name of the file being retrieved

 serialnumber = the serial number of the sensor from which the  
   data is being retrieved.

For example, if you were retrieving a file named Overnight from the three sensors 
selected in the example above, your three files would be:

 Pressure Well 17_Overnight_2901013.a4d
 pH Well 17_Overnight_2902054.a4d
 Conductivity Well 17_Overnight_2903021.a4d

If there is a file on the disk with the same name as the one you are trying to retrieve, 
Aqua4Plus will check to see if it is actually an earlier version of the exact same file.  
If it is, then Aqua4Plus will retrieve only those records since that previous retrieval  
and append them to the end of the file. If the file is different, then an error will be  
generated, and that file will not be retrieved so as not to overwrite any existing data on 
your computer.

Progress information for each sensor will be listed in the status column and overall 
progress information will be shown in bold lettering at the lower left of the window.

When the operation is finished, the status column will display the result of the operation 
for each sensor. If the data was retrieved successfully, the status column will say Data 
Retrieved. 

Logging is not stopped nor are files erased during a retrieval operation. Click the Close 
button to exit the batch processing window. 

BATCH OPERATIONS
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Data Successfully Retrieved

If any error occurred during the operation, a message box will display at the end of  
the operation. Also, the affected sensor will display in red and an error message will 
display in the status column. If you want to try again, select the desired sensors, and 
then click the OK button; if not, click the Cancel button.

Erasing Data

To erase data from a group of sensors, select Batch Operations from the Logging menu, 
and then click on Batch Erase Data. 

The following batch processing window will display. Be sure the sensors you want to 
erase are selected, and then click the OK button. 

Batch Erase Window

BATCH OPERATIONS
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Progress information for each sensor will be listed in the status column and overall 
progress information will be shown in bold lettering at the lower left of the window.

When the operation is finished, the status column will display the result of the  
operation for each sensor. If the data erased successfully, the status column will say 
Erased, and then number of files on the sensors will display as zero. Click the Close 
button to exit the batch processing window. 

Data Successfully Erased

If any error occurred during the operation, a message box will display at the end of  
the operation. Also, the affected sensor will display in red and an error message will 
display in the status column. If you want to try again, select the desired sensors, and 
then click the OK button; if not, click the Cancel button.

Appendix D: Event Logging

The AquiStar PT2X has an additional type of logging available and that is Event  
Logging. When running Event logging, the sensor scans on a specified schedule.  
These scans are not recorded. Each scan is compared to the prior scan, and if the  
difference between these is greater than a specified amount, a record is recorded. This  
is considered to be an event. Even without events, a record will be recorded every xx 
scans, based on what is defined in the setup. The logging will stop after the Logging 
Duration or when the sensor runs out of memory, whichever is first. If you want to use 
Event Logging on your PT2X, please contact Seametrics or refer to the application note  
Event Processing on AquiStar Smart Sensors, available at: www.seametrics.com

BATCH OPERATIONS
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Appendix E: Alternate Connection Options

Seametrics recommends connecting the sensor to your computer using the Seametrics 
USB cable. However, when using Aqua4Plus, the sensor can also be connected using an 
RS232 serial port or a USB-to-Serial cable, as described below. (Note: Aqua4Plus Lite can 
only communicate using the Seametrics USB cable.)

Connecting via RS232 Serial Port

In its cabled configuration, the sensor cable is terminated with a weather-resistant  
connector.  In its cableless configuration, the sensor  is terminated with a weather- 
resistant connector inside a screw-cap. Connect the weather-resistant connector to  
your computer’s serial port as shown below.

Connect the sensor to your computer using an RS485/RS232  
adapter and an interface cable.

Connecting with a USB/Serial Adapter

USB-to-Serial cables are readily available from many electronics and computer stores, 
as well as numerous sites on the Internet. Seametrics has tested and recommends the 
Keyspan USA-19HS. It is available from Seametrics as well as from many sites on the 
Internet. Install as follows:

• Plug into USB port.
• Install the drivers provided with the particular unit.
• Determine the port number to which the adapter is assigned.

 ◦ Right-click on My Computer.
 ◦ From the popup menu, select Manage to open the Computer Management 

window. 
 ◦ On left panel, click on Device Manager.
 ◦ On right panel, double-click on Ports.
 ◦ A list of active COM ports will be displayed. Note the COM number  

assigned to the adapter you just installed.  
For example: 

 ◦ Close Manager.
• Connect to the sensor.

PC or 
Laptop

Computer

RS485/RS232
Adapter

Interface Cable

Serial Port

Sensor

Screw-

Sensor

cap

Cableless 
Configuration

ALTERNATE CONNECTION OPTIONS
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• On the Aqua4Plus software, select the COM port noted above. (If you do not  
see your new COM port in the dropdown box, open the Communications dialog box 
from the Options menu. Increase the Highest COM port number, up to a maximum 
of 15.)

 Connect the sensor to your computer using a 
 USB to Serial adapter and an interface cable.

Interface 
Cable

PC or Laptop
Computer

USB Port
USB-to-Serial 

Adapter

RS232/RS485
Adapter

Sensor

Screw-

Sensor

cap

Cableless 
Configuration

ALTERNATE CONNECTION OPTIONS
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Appendix F: Regional Considerations

Window’s regional settings control such things as how dates are formatted and whether 
a comma or a period is used as a decimal symbol. 

Date Formats

Aqua4Plus does not use the regional settings when displaying dates. All dates are 
displayed as d-mmm-yy, for example, 8-Oct-14. This applies to all Aqua4Plus windows 
and to the exported .csv file. If you open the .csv file in Excel or export in the Excel 
format, dates may be formatted differently, depending on the settings in Excel.

Comma vs. Period

In the United States, a period is used, for example, 12.458. In some countries, a comma 
is used, for example, 12,458. If your computer is set to use the comma, then the Settings 
and Calibration fields in Aqua4Plus will truncate anything after the comma. To work 
around this, you will need to change the Decimal symbol and Digit grouping symbol 
setting in Windows. You should only have to do this during calibration and can change 
back to your normal settings after calibration is complete.

To change these settings:

• Access the Regional and Language settings from Control Panel.
• On Windows 7, click the Additional Settings button; on XP, click the Customize 

button.
• Click the Numbers tab.
• Change the settings as shown below, and then click Apply.

Before changing Settings and Calibration values, select a period as the decimal 
symbol and a comma as the digital grouping symbol. After you are done 
changing the Settings and Calibration values, you can return these settings to 
your normal settings.

REGIONAL CONSIDERATIONS
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SOFTWARE LICENSE & LIMITED WARRANTY/DISCLAIMER - AQUA4PLUS

SOFTWARE LICENSE. The seller grants the user a non-exclusive license to use Aqua4Plus 
(hereafter known as the software), according to the following limitations and conditions.

The user may install  Aqua4Plus on one or more desktop or laptop computers. All title 
and intellectual rights to the software are owned by the seller. No copies may be made 
or distributed except as described above. The user may not modify or reverse engineer 
the software. 

A.   LIMITED WARRANTY. Seller warrants that the software will substantially perform 
the functions described in the accompanying written materials for a period of ninety 
(90) days from the date of receipt. If the software does not conform to the foregoing 
warranty, Seller shall, at Seller’s sole and exclusive option, repair or replace the software 
or refund to the user a prorated portion of the license fee paid.

Seller warrants that any hardware accompanying the software will be free from defects 
in materials and workmanship under normal use and service for a period of one (1) 
year from the date of receipt. Seller’s obligation under this warranty shall be limited to 
replacing or repairing the part or parts or, at Seller’s option, the products which prove 
defective in material or workmanship within ONE (1) year from the date of delivery, 
provided that Buyer gives Seller prompt notice of any defect or failure and satisfactory 
proof thereof.   Any defective part or parts must be returned to Seller’s factory or to an 
authorized service center for inspection.   Buyer will prepay all freight charges to return 
any products to Seller’s factory, or any other repair facility designated by Seller.   Seller 
will deliver replacements for defective products to Buyer (ground freight prepaid) to the 
destination provided in the original order.   Products returned to Seller for which Seller 
provides replacement under this warranty shall become the property of Seller.

Seller’s obligations under this warranty shall not apply to any product with (a) is normally 
consumed in operation, or (b) has a normal life inherently shorter than the warranty 
period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written 
approval by the Seller, all warranties are void.   Equipment and accessories not 
manufactured by the Seller are warranted only to the extent of and by the original 
manufacturer’s warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, WHETHER 
ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY.   IMPLIED WARRANTIES 
OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.   SELLER’S WARRANTY 
OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER (EXCEPT AS TO TITLE) ARE SOLELY 
AND EXCLUSIVELY AS STATED HEREIN.   IN NO CASE WILL SELLER BE LIABLE FOR 
CONSEQUENTIAL DAMAGES, LABOR PERFORMED IN CONNECTION WITH REMOVAL 
AND REPLACEMENT OF THE SENSOR SYSTEM, LOSS OF PRODUCTION OR ANY OTHER 
LOSS INCURRED BECAUSE OF INTERRUPTION OF SERVICE.   A NEW WARRANTY PERIOD 
SHALL NOT BE ESTABLISHED FOR REPAIRED OR REPLACED MATERIAL, PRODUCTS 
OR SUPPLIES.   SUCH ITEMS SHALL REMAIN UNDER WARRANTY ONLY FOR THE 
REMAINDER OF THE WARRANTY PERIOD ON THE ORIGINAL MATERIALS, PRODUCTS OR 
SUPPLIES.
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SOFTWARE LICENSE & LIMITED WARRANTY/DISCLAIMER - AQUA4PLUS CONT..

B.   With respect to products purchased by consumers in the United States for personal 
use, the implied warranties including but not limited to the warranties of merchantability 
and fitness for a particular purpose, are limited to twelve (12) months from the date of 
delivery.

Some states do not allow limitations on the duration of an implied warranty, so the 
above limitation may not apply to you.   Similarly, some states do not allow the exclusion 
or limitation of consequential damages, so the above limitation or exclusion may not 
apply to you.   This limited warranty gives you specific legal rights; however, you may 
also have other rights which may vary from state to state.


